
Traversing the World Wide Web

If you have heard about "surfing the Internet" or if you have joined the millions of users who travel 
the information highway, you will find the World Wide Web the coolest (and most informative) 
experience your computer has given you yet. If you've traversed the Web before, this book gives 
you an essential road map, with directions to thousands of sites that contain millions of documents!

If you are new to the Web, this book gives you everything you need to get started! To begin, we'll 
first introduce you to the Web and discuss how you use it (the pros refer to finding information on 
the Web as "surfing the Web"). Next, you will learn how to use the software we've included on the 
CD-ROM to access the Web for free! In fact, within minutes, you'll be connected to the Web, 
possibly for your first time! 

In short, within this book and CD-ROM, you will find:

    Web browsing software that lets you access the Web

    Offers from online services and providers for free connect time

    A list of over 8,000 Web sites

    Everything you need to "surf the Web"

Note: To move to the next topic is this document, click on the toolbar Next Topic button (the button 
contains two right facing pointers >>). To move back one topic, click on the Previous Topic button 
(<<). To print a topic, choose the File menu Print Topic option.



WHERE THE WORLD WIDE WEB GETS ITS NAME

The World Wide Web consists of millions of related (and interconnected) documents that form a 
web of information that spans the globe. Regardless of the information you need, you'll find 
corresponding topics on the Web. As shown in Figure 1, Web documents reside at computer 
systems dispersed throughout over 130 countries.

Figure 1 Web documents reside in over 130 countries, worldwide.



HOW YOU ACCESS THE WORLD WIDE WEB

To access documents on the World Wide Web, you use special software called a Web browser (the 
CD-ROM that accompanies this book includes browser programs you can use). Using your 
browser, you specify the Web address of the document you desire. Your browser, in turn, will 
display the document's content on your screen. Users refer to a site's document as a home page. For
example, Figure 2 illustrates the White House home page.

Figure 2 The White House home page (Web address: http://www.whitehouse.gov).

From within the White House home page, you can find information about the President and first 
family, as well as information about the executive branch of government, the Vice President and the
congress. In short, the White House home page gives you a starting point from which you can 
access a wealth of information about our government. 

Across the Web, thousands of companies, universities, and even individuals have home pages. For 
example, Figure 3 illustrates the Jamsa Press home page which contains information about our 
books, CD-ROMs, and company. 



Figure 3 The Jamsa Press home page (Web address: http://jamsa.com).

In this case, the Jamsa Press home page provides you with a starting point from which you can 
obtain our catalog, order products, or even read sample chapters of our books!

Every home page on the Web has a unique address. To access a site, you simply tell your browser 
the location you want. This book lists the addresses for over 8,000 Web sites! As you traverse home
pages on the Web, you will encounter hyperlinks that connect you to millions of documents!



WHAT'S ALL THIS ABOUT HYPERLINKED DOCUMENTS

Across the Web, home pages give you a starting location from which you can begin your search for
information. As you view a home page, you may find links to other documents. Web documents 
display such links as icons or underlined text. If you click your mouse on a link, your browser will 
immediately display the linked document's contents. By clicking your mouse on document links, 
you move from one document to another, across the Web. For example, if you click your mouse on 
the Executive Branch link that appears on the White House home page, your browser will display 
the Executive Branch home page as shown in Figure 4.

Figure 4 The Executive Branch home.

As you examine the home pages this book presents, you will find home pages for a wide variety of 
topics. You might for example, find a home page from which you can order books, flowers, or even
pizza. Likewise, other home pages will contain information on large and small companies. If you 
are looking for a college, you can tour many universities right from your PC! 

Most home pages will contain links that take you to other documents. For example, if you are 
looking at the home page for a university, the home page might have links to each of the school's 
departments, as well as a link that takes you on a picture-based tour of the campus! If you are 



looking at a company home page, you will encounter links that display the company's products and 
services.    

For example, if you click on the Catalog link at the Jamsa Press home page, your browser will 
display information on Jamsa Press books and CD-ROMs. From the catalog document, you can 
click on links that take you to documents that describe a specific book or CD-ROM as shown in 
Figure 5.

Figure 5 Using a link to access information on Jamsa Press books and CD-ROMs.

Links within a Web document are so named because they join (or interconnect) related documents. 
Across the Web, links interconnect millions of documents! Because the links let you move quickly 
from one document to another, users call the links, hyperlinks. Web documents, therefore, are 
hyperlinked documents.



TO TRAVERSE THE WEB, YOU NEED INTERNET ACCESS

As you have learned, you use your Web browser (a software program) to traverse the Web. Before 
your browser can access documents on the World Wide Web, you must connect your PC to the 
Internet. As shown in Figure 6, you connect your PC to the Internet using your modem and 
standard phone lines to dial into an Internet provider or online service (such as CompuServe or 
Prodigy).

Figure 6 You connect to the Internet using an online service or Internet provider.

Internet providers are companies, who, for a monthly fee, let you access the Internet (and hence the
World Wide Web) through their physical connection to the Internet. In short, the provider's 
computer is physically connected (by cable or by satellite) to the Internet. Using your modem and 
standard telephone lines, you dial into the provider's computer to gain Internet access. After you 
connect to the Internet, you use your browser to access Web documents.

USING AN ONLINE SERVICE

In addition to using an Internet provider, you can also access the Web (and various Internet 
components) using an online service such as CompuServe and Prodigy. One advantage to using an 
online service to access the Web is cost. The online services are normally less expensive than a 
provider. Second, depending on where you live, you may not have provider access. Because the 
online services are so large, you can normally connect to the service (from most cities) using a 
local phone call. Lastly, the online services may offer more for you (and your family) to do 
"online" than a provider.

The disadvantage of using an online service for Internet or Web access is speed. Your connection to
the Web using an online services is normally slower than a provider-based connection. Because 
many Web documents contain graphics (which require the transmission of large amounts of 
information), speed is very important. If your Internet connection is slow, you may get frustrated 
waiting for your browser to load and display graphics. As such, if you find yourself becoming a 
"net surfer" who spends hours on the Web each day, you should connect to the Internet via a 



provider and enjoy the faster performance.

If you already connect to an online service such as Prodigy, CompuServe, or America Online, you 
can use your service to access the Web. Note, however, your online service may require that you 
have their latest software before you can access the World Wide Web. To obtain the latest software 
from your service, contact your service's technical support.

USING AN INTERNET PROVIDER

If you have already selected an Internet provider or online service, you can use the service to access
the World Wide Web. Depending on your provider, the steps you must perform to access the Web 
may differ. To use your Internet provider to connect the Web, you need to insure that you have a 
SLIP- or PPP-based provider account (contact your Internet provider for more information). The 
SLIP and PPP software let you access the Internet using your modem from within Windows. Next, 
you will need special software you run from within Windows that dials your provider and 
establishes your SLIP or PPP connection. In some cases, your provider may require (or strongly 
recommend) that you use specific software. Contact your Internet provider and ask them to tell you
the specific steps you must perform to connect to the Web and also if they have specific software. 
After you establish your SLIP or PPP connection, you can use your browser to traverse the Web.



TRY OUT THE WORLD WIDE WEB FOR FREE!
To make it very easy for you to connect to the Internet and to access the World Wide Web, Jamsa 
Press has teamed with several major Internet providers and key online services to get you free 
access time on the Internet or significantly reduced startup costs! 

In other words, using software provided on the CD-ROM that accompanies this book, you are only 
minutes from connecting to the World Wide Web for free! We invite you to try out Web access on 
each of the providers and services we've included. Each offers advantages to users with different 
desires and levels of expertise. By test driving each provider, you can access the World Wide Web 
for over a month, for free!

If you live outside of the United States, pay close attention to the providers who have teamed with 
Jamsa Press. As discussed, the Web's presence is worldwide. Jamsa Press worked hard to support 
our international readers by obtaining free connect time or reduced startup fee offers from 
providers around the world!



COOL THINGS YOU CAN DO ON THE WEB

If you've never been out on the Web, or if you've been there, but only to a few sites, you are in for a
real treat! There are thousands of sites across the Web and this book shows you where those sites 
are. For starters, you might want to visit the White House home page previously shown in Figure 2.
After that, you can visit a Mars space exhibit and view pictures of the planets as shown in Figure 7.

Figure 7 A Mars space exhibit (Web address: http://www.mmrc.ncsu.edu/)

After that, you might visit an on-line zoo where you can view live images of the animals (not 
photos). For example, Figure 8 shows a live image of a tropical fish tank that is taken by a video 
camera and later sent out across the Web!



Figure 8 Viewing live images of a tropical fish tank (Web address: 
http://www2.netscape.com/fishcam/fishcam.html)

In this case, the video camera constantly films the fish tank. Once or twice a minute, the site 
displays a new image of the fish. As you traverse the Web, you will encounter live video cameras 
that let you view Seattle, San Diego, and even Norway! 

Lastly, if you are interested in shopping, you will find hundreds of online catalogs from which you 
can order clothes, flowers, books, or even Chinese food or pizzas! Figure 9 illustrates an online 
catalog.



Figure 9 Online catalogs let you shop via the Web (http://www.omix.com/).



HOW TO USE THIS BOOK

As discussed, this book contains the Web addresses for over 8,000 sites. This book organizes Web 
sites by category, presenting each category in alphabetical order, much like a phone book. To use 
this directory, start with your topic of interest. For example, if you are interested in music, you 
would turn to the "M" categories to locate the Music sites. Within each category, you will find a 
range of sites. As shown in Figure 10, each site includes a set of keywords that further describe the 
site. Using the site keywords, you can quickly differentiate between sites that discuss classical 
music and those sites that feature punk rock. 

Figure 10 Keywords further describe each site.

After you find the site you desire, you simply specify the site's Web address to your browser. Web 
site addresses start with the characters http:// as shown in Figure 11. As you type in a site address, 
be careful to type the address exactly as it appears within the book or on the CD-ROM.



Figure 11 Web site addresses immediately follow the home page graphic.

Because books don't have an unlimited number of pages, we've presented home page graphics for 
4,000 Web sites at the front of the book and a categorized listing of over 4,000 more sites at the 
back of the book! Take time now to examine the site listings presented at the back of this book. 
Note the wide variety of site categories.



USING THE CD-ROM THAT ACCOMPANIES THIS BOOK

The CD-ROM that accompanies this book contains software you can use to access the Web as well 
as a full-color directory of over 8,000 Web sites! Using the CD-ROM directory, you can search for 
sites by topic, keyword, or by any text you type. Regardless of your topic of interest, if you search 
the Web Directory CD-ROM, you should find a related Web site.

INSTALLING THE DIRECTORY VIEWER

Before you can use the Web Directory CD-ROM, you must first install software that lets you view 
the CD-ROM files from within Windows. To install this viewer-support software, select the 
Program Manager File menu shown in Figure 12.

Figure 12 The Program Manager File menu.

Select the File menu Run option. Windows will display the Run dialog box. Type D:\SETUP, 
replacing the drive letter D with the drive letter of your CD-ROM drive. For example, if your CD-
ROM drive is drive E, you would type E:\SETUP as shown in Figure 13. 

Figure 13 Installing the Web Directory viewer files.



The Setup program will copy the files to your hard disk, eventually displaying a dialog box that 
tells you the installation is complete. Choose OK. Your screen will now contain the World Wide 
Web Directory group window as shown in Figure 14.

Figure 14 The World Wide Web Directory group window.

To use the Web Directory CD-ROM, double click your mouse on the World Wide Web Directory 
icon. Windows will display the directory's opening screen as shown in Figure 15.

Figure 15 The World Wide Web Directory's opening screen.



BROWSING WEB SITES USING THE CD-ROM

When you view Web sites using the CD-ROM, you are not connected to the Web. Instead, you use 
the Web Directory CD-ROM to look up sites that contain the information you desire. Think of the 
Web Directory CD-ROM as a phone book. Before you place a phone call, you use the phone book 
to look up phone numbers. Likewise, before you connect to the Web, you can use the CD-ROM to 
locate the sites you need.

Just as you can use a phone book to look up numbers while you place other calls, you can use the 
Web Directory CD-ROM to lookup sites while you are connected to the Web. For example, assume
that you are surfing the Web looking for job opportunities. Using the Web Directory CD-ROM, you
can search for sites that discuss jobs or careers. Once you find a site in the directory, you can type 
in the site's Web address into your browser to view the site's document.

VIEWING SITES BY CATEGORY

The CD-ROM directory contains over 8,000 Web sites that we've grouped into almost 100 
categories. To view sites by category, click your mouse on the Categories button. The Web 
Directory, in turn, will display its list of site categories as shown in Figure 16.



Figure 16 The Web Directory site categories.

To view a category's sites, click your mouse on the corresponding category. For example, if you are
looking for information on plants and animals, you might click on the Biology category. The Web 
Directory, in turn, will display the first site in the category as shown in Figure 17.



Figure 17 The first site in the Biology category.

Beneath the site screen image, you will find keywords that describe the site. In addition, you will 
find the site's Web address (the address starts with the letters http://). 

The toolbar near the top of the Web Directory window contains two buttons you can use to move 
forward and backward through a category's sites.

If you click your mouse on the button containing the right-facing arrows (>>), the directory will 
display the next site in the category list. If you click your mouse on the left-facing arrows (<<), the 
directory will display the previous site. If either of these buttons becomes dim, you have reached 
either the first or last site in the category list and you cannot move further in that direction. 

RETURNING TO THE CATEGORY LIST



You can return to the category list from a site at any time by clicking your mouse on the toolbar 
Contents button. Because the category list is too long to fit in a window, you can use the vertical 
scroll bar (that appears along the window's right edge) to view additional categories. To return to 
the Web Directory's main window, click your mouse on the Contents button from within the 
category list window.

PRINTING A SITE

When you find a site within the Web Directory that you later want to visit using your browser, you 
can write down the site's address, or you can print a copy of the site and its address. To print the 
current site, select the Web Directory File menu and choose Print Topic.

VIEWING A SITE'S HTML DOCUMENT

To build a home page, users create a document that uses a special programming language called 
HTML (hypertext markup language). Using HTML, users specify the home page graphics, text 
contents, title bar, and so on.

In addition to providing you with the screens from over 8,000 sites, the Web Directory CD-ROM 
also provides you with each site's HTML document. By including the HTML on the CD-ROM, we 
let you search for topics within over 8,000 HTML documents! In this way, if one of our keywords 
does not match your search topic, you are very likely to find your topic within an HTML 
document! 

If you examine the toolbar, you will find a button titled Hypertext. To display the HTML for a site, 
click you mouse on the Hypertext button. Likewise, to display a site's screen image, click your 
mouse on the toolbar Image button. Figure 18, for example, illustrates the HTML document for the 
White House home page.



Figure 18 The HTML document for the White House home page.

SEARCHING FOR A WEB SITE

The fastest way to list Web sites that discuss your topic of interest is to click your mouse on the 
Search button. The Web Directory, in turn, will display the Search dialog box shown in Figure 19.



Figure 19 The Web Directory Search dialog box.

Within the Search by Word field, type in your topic of interest. If you are interested in Windows 95,
for example, you would type in Windows 95 and press Enter. The Web Directory, in turn, will 
display a Search Results dialog box similar to that shown in Figure 20 that lists the titles of sites 
that discuss Windows 95. By sizing the Search Results dialog box, you can view each site's 
complete title. To size the window, simply drag the window frame using your mouse.

Figure 20 The Search Results dialog box listing sites that discuss Windows 95.

Within the Search Results sites list, double click your mouse on the title of the site you desire. The 
Web Directory will display either the site's screen image or the site's HTML document, depending 
on whether it found your topic within the keyword list or within the HTML text. If the Web 
Directory displays the site's HTML, click your mouse on the Image button to display the site's 
screen.

If the site contains the information you desire, click your mouse on the Cancel button to close the 
Search Results dialog box. Otherwise, double click your mouse on a second site. 

CONTROLLING SEARCH OPERATIONS



By default, the Web Directory will search all 8,000+ sites for your topic text. Using the Search 
dialog box previously shown in Figure 19, you can restrict your search operations to specific site 
categories. For example, if you are a Doctor, you might want to restrict your search operations to 
Medicine, Healthcare, and Science. To constrain your search, click your mouse on the check boxes 
that correspond to the specific categories you want to search.

Depending on your topic, there may be times when a search operation yields hundreds or even 
thousands of matching sites. For example, assume you are interested in sites that discuss 
universities, but only those universities in the state of Washington. To perform such a search, you 
can direct the Web Directory to look for two words, universities and Washington as shown in 
Figure 21.

Figure 21 Searching for two words.

To learn more about advanced searching techniques, click your mouse on the Search dialog box 
Hints button. The Web Directory will display the Search Hints dialog box as shown in Figure 22.



Figure 22 The Search Hints dialog box.

As you can see, you can use the words AND, OR, NEAR, and NOT to perform sophisticated search
operations.

USING AN INDEX TO SEARCH

To find information within a book, you can turn to the book's index to determine which pages 
discuss the topics you desire. In a similar way, the Web Directory CD-ROM contains an index of 
terms. To use the Directory's index to locate sites that discuss your topic of interest, click your 
mouse on the Index button. The Web Directory, in turn, will display the Index dialog box as shown 
in Figure 23.



Figure 23 The Index dialog box.

To locate sites that discuss a specific topic, type in the topic you desire. As you type, the index will 
display words that match the letters you have typed. For example, if you type the letters Boo, the 
Index will display index entries shown in Figure 24.

Figure 24 Index entries matching the letters Boo.

To the right of each index entry, you will find the number of sites that discuss the topic. Next, 
double click your mouse on topic you desire. The Web Directory, in turn, will display the Topics 
Indexed dialog box, shown in Figure 25, that contains the titles of the sites that discuss the topic. 
Again, by sizing the window, you can read the complete site title. Double click on the site you 
desire. The Web Directory will display either the site's image or HTML. 



Figure 25 The Topics Indexed dialog box.

SELECTING AN INDEX

The Web Directory CD-ROM lets you search for information by category, keywords, and by text 
contained in a site's HTML document. To control your search operations, the Web Directory uses 
three different indexes as described in Table 1.

Index Contents
Keyword Contains the keywords that appear beneath the site graphic.
Category Contains a listing of the site categories.
Web Site Index Contains words found in the site HTML documents.

Table 1 The Web Directory search indexes.

To search a specific index, open the Index dialog box Current index pull-down list and click your 
mouse on the index you desire.

ANNOTATING A SITE ADDRESS

Over time, Web sites may change or cease to exist. If you are using the book version of the World 
Wide Web Directory, you can make an appropriate note on the page of the book that contains the 
site. Likewise, if you are using the Web Directory CD-ROM, you can make annotations to a site.

To annotate the current site, select the Edit menu Annotate option. The Web Directory, in turn, will 
display the Annotate dialog box as shown in Figure 26.



Figure 26 Annotating a site address.

Type in your annotation, such as a new site address, and select Save. The Web Directory, in turn, 
will display a small paper clip above the left-hand corner of the site's screen image. To display the 
annotation, click your mouse on the paper clip. 

VIEWING A PREVIOUSLY VIEWED SIGHT

As you click through the sites in the Web Directory CD-ROM, there may be times when you want 
to view a site that you saw earlier, but whose category you no longer remember. In such cases, click
your mouse on the toolbar History button. The Web Directory, in turn, will display the History 
dialog box similar to that shown in Figure 27 that contains a list of sites you have previously 
viewed. Double click your mouse on the site you desire.

Figure 27 The History dialog box.

MARKING YOUR FAVORITE SITES



If you use the book version of the World Wide Web Directory, you may find yourself marking the 
pages of the sites you use on a regular basis. In a similar way, you can place bookmarks on your 
favorite sites within the Web Directory CD-ROM. After you assign a bookmark to a site, you can 
select the site quickly from the Bookmark menu. To assign a bookmark to the current site, select 
the Bookmark menu and choose Define. The Web Directory will display the Define dialog box. 
Choose OK.

EXITING THE WEB DIRECTORY CD

To exit the Web Directory CD-ROM, select the File menu Exit option or click your mouse on the 
Exit menu button that appears on the Directory's opening window.



OUR WEB SITE DISCLAIMER

The World Wide Web is a dynamic entity that constantly changes. In fact, the number of new Web 
sites created each day now numbers several hundred! As we studied the behavior of sites on the 
Web, we found that sites change and sometimes cease to exist. When we made our site selections 
for this book, we worked hard to choose stable sites. Unfortunately, despite our best efforts, you 
may periodically encounter a site address that is no longer valid. Luckily, based on the shear 
number of sites (over 8,000) that we've given you, we are very confident that you will find ample 
sites that discuss your topic of interest.



ADDING YOUR HOME PAGE TO A FUTURE EDITION

Jamsa Press is very interested in obtaining "cool" or "content rich" home pages for future editions 
of this book. To include your home page in a future edition, simply send us an e-mail message that 
contains your Web site address (send to homepage@jamsa.com). For example, to include the White
House home page in a future edition of this book, the President would send the following e-mail 
message:

Send: homepage@jamsa.com

Subject: Add our home page

Message

Please add the following home page:

http://www.whitehouse.gov

Thanks, The President



CREATING YOUR OWN HOME PAGE

If you have a business with products you want to advertise, you can create your own home page 
that is accessible to millions of users across the Web. To create your own home page, you need to 
format a home page document using a special language called HTML. Second, you need Web 
server software that lets other users access your home page.

To make it easy for you to perform these operations, Jamsa Press has created a multimedia CD-
ROM titled Instant World Wide Web Access. The CD-ROM contains 45 minutes of video that 
teaches you how to use HTML and how to use Web server software. In addition, the CD-ROM 
includes all the software you need! You will find Instant World Wide Web Access (ISBN: 1-884133-
20-7) at fine bookstores and computer stores. For more information on Instant World Wide Web 
Access, connect to the Jamsa Press home page (Web address: http://jamsa.com).



ACCESSING THE WEB FOR YOUR FIRST TIME

If you don't currently use an online service or Internet provider, your first step is to choose one of 
the services this book makes available to you. As discussed, Jamsa Press has teamed with services 
who will give you free connection time to the Web or who will significantly reduce your startup 
costs. Use the descriptions that follow to connect to and try out each service. In this way, you not 
only get a chance to access the Web for free, you get to choose the service that best suits your 
needs. 

Note: Over time, the services and discounts that the providers and online services offer may 
change. In some cases, a company's promotion may become even better than those offered here 
(more free hours or further reduced costs). The companies that follow are free to change their 
promotional offers at any time. Jamsa Press is not responsible for, nor can Jamsa Press control 
such changes. Jamsa Press makes these companies available to you in an attempt to simplify your 
first Web connection. We will continue to seek out such partners in the future who are committed to 
providing services to our valued customers.



ACCESSING THE WEB USING PRODIGY

Prodigy Information Services is one of the largest online services in the world. Using Prodigy, you 
can shop, get the latest sports, travel, and financial news, chat with or send electronic mail (e-mail) 
to users from around the world. In fact, with Prodigy you may converse with politicians, athletes, 
musicians, and even TV and movie stars! Your major motivation for using Prodigy is that it 
provides something for everyone in your family! 

Prodigy also lets you access various parts of the Internet such as e-mail, newsgroups, but most 
importantly, the World Wide Web! Because Prodigy supports a wide range of users, each with 
different levels of expertise, you will find Prodigy one of the easiest ways to access the Web. 

To give you a chance to test drive the Web, as well as, Prodigy's standard services, Prodigy will let 
you try them out for 10 hours, for free!

HELP FROM PRODIGY

If you experience any problems when you install or connect to Prodigy, contact Prodigy at the 
following number:

Prodigy Support
1-800-PRODIGY

INSTALLING THE PRODIGY SOFTWARE

Many PCs ship with Prodigy already installed. If your system already has Prodigy, you can 
continue your reading at the section titled "Connecting to Prodigy." Note, however, to access the 
Web, you may need to install the latest version of the Prodigy software. If, when you try to "JUMP 
WWW" within Prodigy to access the Web, Prodigy displays an error message stating you need 
newer software, install a new version of Prodigy by following the steps discussed here.

To start the Prodigy installation, place the World Wide Web Directory CD-ROM into your CD-
ROM drive. Next, from within Windows, select the Program Manager's File menu shown in Figure 
28.



Figure 28 The Program Manager's File menu.

Select the File menu Run option. Windows, in turn, will display the Run dialog box. Within the 
Command line field, type in he command D:\PRODIGY\INSTALL, replacing the drive letter D 
with the drive letter that corresponds to your CD-ROM drive. For example, if your CD-ROM drive 
is drive E, you would type E:\PRODIGY\INSTALL as shown in Figure 29.

Figure 29 Starting the Prodigy installation program.

As shown in Figure 30, the Prodigy installation program will display a dialog box asking you to 
specify the drive and directory within which you want to install the Prodigy software. 



Figure 30 Specifying the directory to hold the Prodigy files.

Type in the directory that you desire and click your mouse on OK. To simplify your software setup,
the Prodigy installation program will display the Modem Search dialog box shown in Figure 31 
which asks you if you want it to locate your modem (and automatically configure the modem for 
Prodigy's use).

Figure 31 The Modem Search dialog box.

Click you mouse on the Search button to direct the Prodigy installation program to perform the 
modem search. When the program locates your modem, it will display the Modem Found dialog 



box as shown in Figure 32.

Figure 32 The Modem Found dialog box.

Click your mouse on the OK button to continue the installation. The Prodigy installation program, 
in turn, will copy the software files to your disk. When the Prodigy installation is complete, the 
installation program will display the Installation Complete dialog box. Select OK. Windows will 
display the PRODIGY software group window as shown in Figure 33.

Figure 33 The PRODIGY software group window.

CONNECTING TO PRODIGY

To connect to Prodigy, double click your mouse on the PRODIGY software for Windows icon. The 
Prodigy software, in turn, will display the Prodigy Network SIGN-ON window as shown in Figure 
34.



Figure 34 The Prodigy Network SIGN-ON window.

IF YOU ARE ALREADY A PRODIGY MEMBER

If you already have a Prodigy account, click your mouse on the button that states you are a member
and want to sign on. Continue your reading with the section titled "Accessing the Web With 
Prodigy."

IF YOU WANT TO TEST DRIVE PRODIGY

If you are not yet a Prodigy member, click your mouse on the button stating you want to enroll. 
Prodigy, in turn, will display a Welcome! dialog box that describes the screens you will encounter 
next. Choose OK to continue. Prodigy will display the Confirm Dialing and Modem Information 
dialog box as shown in Figure 35.



Figure 35 The Confirm Dialing and Modem Information dialog box.

This dialog box lets you tell the Prodigy software special dialing instructions as well as your 
modem settings. If you let the Prodigy installation detect your modem, the modems settings should 
be correct. If you work in an office that requires you to dial 9 to access and outside line, click your 
mouse on the corresponding check box. After you verify the modem and dialing settings, select 
OK.

The Prodigy software will connect you to the Prodigy service so you can obtain your new account 
information. Click your mouse on the right facing button. Prodigy will display the Phone Directory 
window shown in Figure 36.



Figure 36 The Phone Directory window.

Click your mouse on the flashing (right pointing) arrow and Prodigy will display a window asking 
you for your area code and the first three digits of your phone number. For example, if your phone 
number is 702-248-6111, you would enter 702 in one box and 248 in the other. Type in your phone 
information and click on Start Search. Prodigy, in turn, will display a window similar to that shown
in Figure 37 that displays the local area access phone number you will use to access Prodigy. Using
the local area access number, you eliminate long distance phone costs to use the Prodigy service.



Figure 37 The local access phone number window.

If the local number Prodigy has selected looks correct, press Enter. Otherwise, highlight the correct 
number and press Enter. Prodigy will then display a dialog box asking if your phone line supports 
call waiting. If your phone line supports call waiting, you can temporarily turn off call waiting to 
prevent an incoming call from disconnecting your modem. Click on Yes or No. If you select Yes, 
Prodigy will display a dialog box asking you how you want it to handle incoming phone calls. 
Click on the choice you desire.

Depending on where you live, the Prodigy local access phone number may still be a long-distance 
call. As such, Prodigy will display a dialog box asking if you will need to dial 1 to access Prodigy's 
local access phone number. Click on Yes or No. Prodigy will display a window within which you 
can select an alternate number that Prodigy uses when your primary is number is busy. Click on the
alternate number you desire or select the No Alternate button. If you select an alternate number, 
Prodigy will again display a dialog box asking you if you need to dial a 1 to access the number. 
Click on Yes or No. 

Prodigy will now display a dialog box showing you the choices you have selected. Click your 
mouse on the Save button. You are now ready to access Prodigy! Click your mouse on the 
Reconnect Now button. Prodigy will display the Country Selection dialog box. Click your mouse 



on USA or Canada. Prodigy, in turn, will display a screen that lists their current account offer (free 
time and rates). Click your mouse on Continue. Prodigy will display the Service Enrollment 
window as shown in Figure 38.

Figure 38 The Service Enrollment window.

Type your name, address, and phone number. Click your mouse on Continue. Prodigy will display 
a dialog box asking you for your payment method. Normally, you will specify credit card 
information. Prodigy will not charge your credit card during your trial period. Specify your 
payment method and continue. Prodigy will display a dialog box asking you to accept the 
membership terms. Do so and continue. Next, Prodigy will display a dialog box asking you to type 
your password. Select your password and type it twice.

Prodigy will now display your user id and password. Write down this information. You are now 
ready to use Prodigy. Your screen will display the PRODIGY software window shown in Figure 39.



Figure 39 The PRODIGY software window.

If you are currently connected to Prodigy, continue your reading with the section titled "Accessing 
the Web Within Prodigy"; otherwise, follow the steps discussed next to log into Prodigy.

SIGNING ON TO PRODIGY

To sign on to Prodigy, double click your mouse on the PRODIGY software for Windows icon. 
Windows, in turn, will display the Network Sign-On dialog box as shown in Figure 40. 



Figure 40 The Network Sign-On dialog box.

Type in your user id and password and click on Connect. Prodigy, in turn, will log you into the 
Prodigy Services displaying Prodigy's opening screen, similar to that shown in Figure 41.



Figure 41 The Prodigy Services opening screen.

Note: Within the Network Sign-On dialog box, you can direct Prodigy to immediately connect you 
to its World Wide Web browser.

ACCESSING THE WEB FROM WITHIN PRODIGY

To access the World Wide Web from within Prodigy, click your mouse on the Jump menu. Prodigy, 
in turn, will display the Jump dialog box. Within the Jump dialog box, type WWW as shown in 
Figure 42.



Figure 42 Jumping to the World Wide Web.

Because Prodigy cannot control the Web's contents, Prodigy may ask you to select your family 
members who can access the Web. In addition, Prodigy may need to download (copy) new software
to your PC. Follow the instructions Prodigy displays on your screen to perform these operations. 

Eventually, Prodigy will display the Web browser as shown in Figure 43. Click on the window's 
Maximize button (the small upward pointing arrow button that appears to the right of the window's 
title bar) to expand the window to full screen.



Figure 43 The Prodigy Web browser.

To select different Web sites, first choose the addresses from this book that you desire. Next, click 
you mouse in the URL field and type in the address. For example, to connect to Jamsa Press you 
would type http://jamsa.com.

To display a Web site's information, your browser must download file information across the Web. 
As the Prodigy browser returns the information from across the Web, it will spin the small Prodigy 
icon. The spinning icon is your indication that your browser is working. At the bottom of your 
screen, you will find a status bar that indicates how far the browser has progressed with the 
download. 

EXITING THE PRODIGY BROWSER

To exit the Prodigy browser, select the File menu Exit option. Prodigy, in turn, will display its 
standard services screen. To exit Prodigy, (to sign off) again select the File menu and choose Exit. 
Prodigy will display the Exit dialog box. Select End this Session.



GETTING MORE INFORMATION ABOUT THE PRODIGY WEB BROWSER

As you spend time on the Web, you can save considerable time and effort using the browser's 
advanced features. To learn more about the Prodigy Web browser, select the Help menu option. 
Within the browser's online help, you will find extensive information about all browser capabilities.



ACCESSING THE WEB USING PSINET

PSINet is one of the largest and fastest growing Internet providers in the world. Using PSINet, you 
not only gain access to the World Wide Web, but also to all Internet resources such as e-mail, ftp, 
gopher, online chatting, and newsgroups! To make it easy for you to access the Internet (and the 
Web), PSINet lets you connect to and test drive the Internet for seven days, for free! 

HELP FROM PSINET

If you experience any problems when you install or connect to PSINet, contact PSINet at the 
following number:

PSINet Support
1-703-904-7748

INSTALLING PSINET SOFTWARE

PSINet provides you with access to a collection of software programs, developed by NetManage, 
called Internet Chameleon. To install the Chameleon software, select the Program Manager File 
menu and choose Run. Windows, in turn, will display the Run dialog box. Within the Command 
line field, type D:\PSINET\SETUP, replacing the drive letter D with the drive letter of your CD-
ROM. For example, if your CD-ROM drive is drive E, you would type E:\PSINET\SETUP as 
shown in Figure 44. 

Figure 44 Installing the NetManage Chameleon software.

Click your mouse on OK. The Setup program will display the Setup dialog box shown in Figure 
45.



Figure 45 The NetManage Chameleon Setup dialog box.

The Setup dialog box lets you specify the disk drive and directory within which want to install the 
Chameleon software programs. Type in the directory you desire and select Continue. The Setup 
program will copy the software to your hard disk. After the Installation program is complete, Setup 
will display a message box so stating. Choose OK. Your Internet Chameleon group window will 
appear as shown in Figure 46.

Figure 46 The Internet Chameleon group window.

REGISTERING WITH PSINET

After you install the Chameleon software, you must register with PSINet (obtain an account). To 
register, click your mouse on the Instant Internet icon within the Internet Chameleon group 



window. Windows, in turn, will display the PSI InterRamp window as shown in Figure 47.

Figure 47 The PSI InterRamp window.

Click your mouse on Signup. Windows will display the Instant Internet Account Sign Up dialog 
box as shown in Figure 48.



Figure 48 The Instant Internet Account Sign Up dialog box.

Type in your name, address, and phone information. In addition, you must provide credit card 
information. PSINet will not charge your credit card during your free 7 day demonstration period. 
PSINet will only bill your credit card if you continue to use the service following your trial period. 
After you specify the information, click your mouse on Send. The registration software will dial 
into PSINet, displaying the PSINet terms and conditions. Read the terms and choose Continue. 
PSINet will display a billing information dialog box as shown in Figure 49.

Figure 49 The PSINet billing information dialog box.

Select the free demo button and choose Continue. After the software successfully registers you, it 
will display a dialog box containing your username and password. Write down your username and 
password and also save this information to a file by clicking your mouse on the save to file button. 



Click on OK to complete your registration. The registration software will now need to restart your 
system. Select the Restart Now button.

CONNECTING TO PSINET

To connect to PSINet, double click your mouse on the Custom (Connect Here) icon. Windows, in 
turn, will display the Custom window shown in Figure 50.

Figure 50 The Custom window.

Most users will use a PPP connection (as opposed to ISDN). Highlight the PPP entry and click your
mouse on the Connect button. The Custom software will dial into your local access number, 
connecting you to PSINet.

Within the Internet Chameleon group window, click your mouse on the WebSurfer icon. Windows, 
in turn, will display the WebSurfer window as shown in Figure 51.



Figure 51 The WebSurfer window.

Click on the window's maximize button (the upward facing button that appears to the right of the 
title bar) to display the browser using the full screen. Within the URL field, type in the Web address
of the site you desire. 

LEARNING MORE ABOUT WEBSURFER

To maximize your Web productivity, you will want to use several of the WebSurfer's advanced 
features. To learn more about the WebSurfer, select the Help menu to access the WebSurfer online 
help. 

EXITING THE WEBSURFER

To exit the WebSurfer, select the File menu Exit option. To disconnect from PSINet, select the 
Custom window Disconnect menu option.



ACCESSING THE WEB USING NETCOM
NETCOM is one of the largest and fastest growing Internet providers. When you connect to 
NETCOM, you not only gain access to the World Wide Web, but you can access all Internet 
resources as well, such as e-mail, ftp, gopher, WAIS, and so on! To make it easy for you to connect 
to the Internet, NETCOM has waived their standard start-up fees for readers of the World Wide 
Web Directory! As discussed next, it's very easy to connect to NETCOM. Within minutes, you will 
be connected to the World Wide Web.

HELP FROM NETCOM

If you experience any problems when you install or connect to NETCOM, contact NETCOM at the
following number:

NETCOM Support
1-408-983-5950

INSTALLING THE NETCOM SOFTWARE

To make it easy for you to access the Internet, NETCOM provides special software called 
NetCruiser. To install NetCruiser, select    the File menu and choose Run. Windows, in turn, will 
display the Run dialog box. Within the Command Line field, type D:\NETCOM\SETUP, 
replacing the drive letter D with the drive letter of your CD-ROM drive. For example, if your CD-
ROM drive is drive E, you would type E:\NETCOM\SETUP as shown in Figure 52.

Figure 52 Running the NetCruiser installation.

The Setup program, in turn, will display the Welcome to NetCruiser windows as shown in Figure 
53.



Figure 53 The Welcome to NetCruiser Setup window.

Type in the drive and directory within which you want Setup to install the NetCruiser software and 
choose Continue. The Setup program will place the program files on to your hard disk. 

For the NetCruiser software to work, the Setup program will need to modify your 
AUTOEXEC.BAT file. As such, Setup will display a dialog box asking you if it can modify 
AUTOEXEC.BAT. Select Yes. After the NetCruiser software is installed, the Setup program will 
display a Start Registration dialog box as shown in Figure 54 letting you register (create an 
account) with NETCOM.

Figure 54 The Start Registration dialog box.

Select Start Registration. Setup will display the Welcome to NetCruiser! dialog box as shown in 
Figure 55, telling you that to register, you will need to specify your name, phone number, credit 
card, and username information.



Figure 55 The Welcome to NetCruiser! dialog box.

Your username is the name other users will use to send you electronic mail. My username, for 
example, is kjamsa. To sign on to NETCOM, you must specify a password which you keep private.
Do not let another user know your password. Do not use a password that another user might easily 
guess.

Select the Continue button. Setup will display the Have You Registered Before? dialog box as 
shown in Figure 56.

Figure 56 The NETCOM Have You Registered Before? dialog box.

Select the appropriate button and choose Continue. Setup will display the Registration Information 
dialog box as shown in Figure 57.



Figure 57 The Registration Information dialog box.

Complete the registration fields and choose Continue. Setup will display the Confirmation dialog 
box telling you your username and e-mail address. If the information in the dialog box is correct, 
select Yes. Otherwise, select No.

Setup will display the Secret Word dialog box asking you to type a secret word that only you and 
NETCOM will know. Should you forget your password in the future, you can call NETCOM, tell 
them your secret word, and they will change your password. Type in (and write down) your secret 
word and choose Continue. Setup will display your registration code. Write down your registration 
code number and choose Continue.

Setup will then display the Registration Connection dialog box telling you that it will register your 
account using NETCOM's 800 number. Click your mouse on the Use 800 Number button. Setup 
will display the Dial Toll-Free number dialog box asking you if you need to dial a 1 and possibly 
any other numbers to access an 800-number line. Type in any prefix numbers you require and 
choose OK. Setup will display a dialog box telling you the dialing information is complete. Choose
Continue.

To simplify you NETCOM connection, the Setup software can detect and configure your modem. 
As such, Setup will display the Modem Setup dialog box shown in Figure 58.



Figure 58 The Modem Setup dialog box.

Select Automatic Setup. The Setup software will detect your modem, displaying the Modem 
Detection Result dialog box. If your modem information is not correct, choose Configure. 
Otherwise, if the information is correct, choose Done. Setup will display the Confirm Modem 
Parameters dialog box. Select Continue. The Setup program will now display the Start Registration 
dialog box. Choose Continue. Setup will now dial NETCOM, starting your registration process.

Setup will display the Dial-In Phone Number dialog box. Select the Directory button. Setup will 
display the Choose A Dial-In Phone Number dialog box as shown in Figure 59.

Figure 59 The Choose A Dial-In Phone Number dialog box.



Within the dialog box list of cities, select the city and phone number you want the NetCruiser 
software to dial to access NETCOM and choose OK. Setup will redisplay the Dial-In Phone 
Number dialog box. Choose Continue. Setup will then display the Billing Information dialog box 
shown in Figure 60 asking you to specify how you want to pay for your account.

Figure 60 The Billing Information dialog box.

Specify your charge card type, number, and expiration date and choose Continue. Setup will 
display the NETCOM Terms and Conditions dialog box. Read the terms and conditions and choose
Continue. Eventually, Setup will display a dialog box telling you that your registration is complete. 
Select OK. 

SIGNING ON TO NETCOM

To sign on to NETCOM, double click your mouse on the NetCruiser icon. Windows, in turn, will 
display the NetCruiser Login dialog box as shown in Figure 61.



Figure 61 The NetCruiser dialog box.

Click on the Username field and type in your username. Click on the Password field and type in 
your password. Click on the Start Login button. NetCruiser will dial the local access number to 
connect your PC to NETCOM. After you connect, your NetCruiser software will display a toolbar, 
as shown in Figure 62, whose buttons you can use to access the Web and other Internet resources.

Figure 62 The NetCruiser toolbar.

To access the World Wide Web, click your mouse on the spider web icon. NetCruiser, in turn, will 
display its Web browser as shown in Figure 63.



Figure 63 The NetCruiser Web browser.

Click your mouse on the window's maximize button to display the browser using the full screen. 
Next, click your mouse on the text box that appears near the top of the window and type in a Web 
site address. 

EXITING THE WEB BROWSER

To exit the Web browser, select the Control menu Close option. To disconnect from NETCOM, 
select the File menu Exit option.



ACCESSING THE WEB USING COMPUSERVE

CompuServe is one of the leading online services worldwide. Using CompuServe, you can shop, 
chat with or send e-mail to other users worldwide, get the latest sports, news, and travel 
information, and much more! In addition, CompuServe provides you with access to the World Wide
Web. 

To make it easy for you to access their standard services as well as the Web, CompuServe will 
provide you with one free month of access and a $15.00 credit against expenses you incur while 
traversing the Web! 

HELP FROM COMPUSERVE

If you experience any problems when you install or connect to CompuServe, contact CompuServe 
at the following number:

CompuServe Support
1-800-848-8990
1-614-457-8650

INSTALLING THE COMPUSERVE SOFTWARE

To install the CompuServe software, select the Program Manager's File menu shown in Figure 64.

Figure 64 The Program Manager File menu.

Choose the Run option. Windows, in turn, will display the Run dialog box. Within the Command 
line field, type D:\COMPUSRV\SETUP, replacing the drive letter D with the drive letter of your 
CD-ROM drive. For example, if your CD-ROM drive is drive E, you would type E:\COMPUSRV\



SETUP as shown in Figure 65.

Figure 65 Installing the CompuServe software.

Chose OK. The Setup program will display the WinCim dialog box shown in Figure 66 asking you 
to specify the drive and directory within which you want to place the CompuServe software.

Figure 66 The WinCim directory dialog box.

Type in your desire directory location and choose OK. Setup will display a dialog box asking you if
you want CompuServe to support sounds. If your computer has a sound card, choose Yes. Next, 
Setup will display a dialog box asking if you want to copy Signup files. If you have an existing 
account, select No. If you are creating a new account, select Yes and Setup will copy files to your 
hard disk, eventually displaying the Signup dialog box shown in Figure 67 asking you if you want 
to sign up with CompuServe. 

Figure 67 The Signup dialog box.

To create a new account, select Yes. Setup will open the Signup window. Click your mouse on 



Proceed. The Setup program will display the CompuServe Signup window shown in Figure 68.

Figure 68 The CompuServe Signup window.

Select the Sign Me Up button. The Setup program will display the Signup-Billing/Country dialog 
box shown in Figure 69.

Figure 69 The Signup-Billing/Country dialog box.



Use the Agreement Number and Serial Number provided on the CompuServe card that 
accompanied this book. If you need assistance with your numbers, contact CompuServe at:

CompuServe Information Services, Inc.
Customer Administration
Box 20212
Columbus, Ohio 43220
U.S. Tel: 800-848-8990
Elsewhere: 614-529-1340

Complete the dialog box fields and select Proceed. The Setup program will display the Personal 
Information dialog box shown in Figure 70.

Figure 70 The CompuServe Signup Personal Information dialog box.

Complete the dialog box fields and choose Proceed. The Signup program will display a dialog box 
asking you if you want to receive the free CompuServe magazine and participate in user 
directories. Select the Option you desire and choose Proceed.

The Signup program will display a dialog box containing the CompuServe Information Services 
Agreement Terms. Read the terms and choose Proceed. The Signup program will display the Phone
Dial Type dialog box shown in Figure 71.



Figure 71 The Phone Dial Type dialog box.

Select your phone type (if your phone beeps when you dial, you have a touch tone phone). If you 
work within an office where you must dial 9 or some other number to access an outside line, type 
in the prefix and select Proceed. The Signup program will display the Communications Port dialog 
box shown in Figure 72.



Figure 72 The Communications Port dialog box.

Select the port that corresponds to your modem or choose the Auto-Detect button to direct the 
Signup program to identify your modem port. Select OK. When the Signup program displays the 
Signup dialog box, select the Sign up button. The Signup program, in turn, will dial CompuServe 
and start your registration. Eventually, your screen will display a Welcome window. Read the 
window's text and type Agree in the small box that appears near the lower-left corner of the 
Welcome window. Select Proceed. The Signup program will reconnect you to CompuServe and 
continue your registration.

Eventually, the Signup program will display a dialog box that contains your user id and password. 
Write down this information and select Proceed. The Signup program will then display an Account 
Information dialog box. Type in your user id and password to acknowledge to CompuServe that 
you received them. The Signup program will display a Personal Information window. Read the 
window's contents and select Close. Your screen will now contain the CompuServe group window 
as shown in Figure 73.

Figure 73 The CompuServe group window.



SIGNING ON TO COMPUSERVE

To sign on to your CompuServe account, double click your mouse on the CompuServe Information
Manager icon. Windows will display the CompuServe Information Manager window shown in 
Figure 74.

Figure 74 The CompuServe Information Manager window.

Within the Connect to CompuServe dialog box, select Connect. Your software will dial and connect
to CompuServe. Within CompuServe's main screen, click on the Internet icon. CompuServe will 
display the CompuServe Internet Services window. Select the World Wide Web option. 
CompuServe, in turn, may display additional windows from within which you can download 
(copy) the Web software to your PC.

Note: Before you begin the Web software download operation, make sure you are connected to 
CompuServe using your modem's fastest speed. Use the Special menu Settings option to set your 
modem speed. If you change your modem speed, disconnect from CompuServe and sign back in 
before you start the Web software download operation. Should your modem disconnect during the 
download, CompuServe will let you resume the operation where previous download operation left 
off.



After you download the Web software installation program, you must run the program to install the 
Web software for use. To run the program, select the File menu Run option. 

Note: By default, CompuServe places the files you download into the \CSERVE\DOWNLOAD 
directory. To run Web software installation program, you must specify the directory that contains 
the program.

After you install the Web software, your CompuServe group window will contain several new 
icons including the Spry Mosaic icon as shown in Figure 75.

Figure 75 The CompuServe group window with Web software.

To access the Web using CompuServe, double click your mouse on the Spry Mosaic icon. 
Windows, in turn, will display the Spry Mosaic window as shown in Figure 76. In addition, a 
second program (called the Internet Dialer) will dial CompuServe and establish a connection. 



Figure 76 The Spry Mosaic window.

To display a Web site using the browser, click your mouse on the URL field and type in a Web site 
address.

EXITING THE COMPUSERVE BROWSER

To exit the Spry Mosaic browser, select the File menu Exit option. Next, double click on the 
Internet Dialer icon and choose Hangup. To close the Internet Dialer window, select the File menu 
Exit option.



ACCESSING THE WEB USING I-LINK

I-Link is a US-based Internet provider with plans to expand worldwide over the next year! When 
you connect to the Internet using I-Link, you gain access to the World Wide Web, and all other 
Internet resources such as e-mail, ftp, gopher, WAIS, and so on! To make it easy for you to connect 
to the Internet, I-Link will give three days free access for readers of the World Wide Web Directory!
As discussed next, it's very easy to connect to I-Link. Within minutes, you will be connected to the 
World Wide Web.

HELP FROM I-LINK

If you experience any problems when you install or connect to I-Link, contact I-Link at the 
following number:

I-Link Support
1-512-388-2846

INSTALLING THE I-LINK SOFTWARE

To install the I-Link Software, select the Program Manager's File menu and choose Run. Windows, 
in turn, will display the Run dialog box. Within the Command line field, type D:\ILINK\SETUP, 
replacing the drive letter D with the drive letter that corresponds to your CD-ROM drive. For 
example, if your CD-ROM drive is drive E, you would type E:\ILINK\SETUP as shown in Figure 
77.

Figure 77 Installing the I-Link software.

The Setup program will display the Installation Location dialog box asking you to specify the 
directory within which you want to store the I-Link files. Type in the drive and directory that you 
desire and press Enter. Setup will then display a dialog box asking you that if it can modify your 
AUTOEXEC.BAT file. Select Yes. Setup will display a dialog box telling you that it has 
successfully modified AUTOEXEC.BAT. Select OK.

After Setup copies the I-Link files to your hard disk, Setup will display a dialog box stating the 
installation is complete. Select OK. Windows, in turn, will display the I-Link window shown in 
Figure 78. The Setup program will continue your software installation by displaying a dialog box 
that contains the instructions you must follow to register with I-Link. Select OK.



Figure 78 The I-Link window.

Within the Personal Info sheet, type in your name, address, and phone number. Next, click your 
mouse on the Forward button. Windows, in turn, will display the Modem and Dialing dialog box    
as shown in Figure 79.



Figure 79 The Modem and Dialing dialog box.

If you work in an office where you must dial 9 to access an outside line, type that number within 
the Dialing Prefix field. Next, open the Modem pull-down list and select the modem type that 
corresponds to your modem.    In a similar way, open the Com Port pull-down list and select your 
modem's port. Lastly, open the Baud Rate pull-down list and select your modem speed. Click your 
mouse on the Forward button. Windows, in turn, will display the User Info sheet as shown in 
Figure 80.



Figure 80 The User Info sheet.

Within the Choice fields, type in three choices for your username. In my case, I would use kjamsa, 
k_jamsa, and possibly kris_jamsa. Within the Password field, type in the password you desire. 
Select a password that you can easily remember but that others cannot easily guess. Click your 
mouse on the Forward button. Windows will display the Payment Info sheet as shown in Figure 81.



Figure 81 The Payment Info sheet.

In the Credit Card Information fields, type in the name that appears on your credit card, your card 
number, and your card's expiration date. In the Service Level fields, select the button that 
corresponds to the connection program you desire. As you click your mouse on the Gold and 
Platinum buttons, the dialog box will display I-Link's corresponding rates. Within the Base Service 
Payment Interval field, specify how you want I-Link to bill you. Click your mouse on the Forward 
button. Windows will display the I-Link Shop sheet as shown in Figure 82.



Figure 82 The I-Link Shop sheet.

The I-Link Shop sheet lets you download new software and create installation disks for other 
computers. Click your mouse on the Info button for each option to view text that describes the 
option. Most I-Link users will want to download the Enhanced Mosaic software and new I-Link 
software. Before you can do so, however, you must register your account with I-Link.

REGISTERING WITH I-LINK

To register your account with I-Link, click your mouse on the Register button. The I-Link software,
in turn, will display a dialog box asking you if you want it to connect your PC to I-Link and 
register your account. Select Yes. After the software completes your account registration, it will 
display a dialog box so stating. Choose OK.

Within the Modem and Dialing sheet, open the Access Number pull-down list and select the local 
access phone number closest to your calling location. If a local number is not available, contact I-
Link ask when they will have a number available. If I-Link does not have a local number available, 
use a different provider until I-Link can offer you a local number.    

If I-Link offers you a local number, select the number and again click your mouse on the 



Registration button. The I-Link software will again connect your PC to I-Link. Eventually, the 
softer will display a dialog box telling you that your registration is complete. Write down your user 
id the dialog box displays. You are now ready to download the Enhanced Mosaic software.

DOWNLOADING THE ENHANCED MOSAIC SOFTWARE

To download the Enhanced Mosaic Web browser, select the I-Link Shop sheet. Next, click your 
mouse on the Download button that corresponds to Mosaic. The I-Link software will connect your 
PC to I-Link and download the browser. When the download operation is complete, the I-Link 
software will automatically run a Setup program you use to install Enhanced Mosaic. When the 
Setup program completes, your I-Link group window will contain an icon for Spry Mosaic as 
shown in Figure 83.

Figure 83 The Spry Mosaic icon within the I-Link group window.

Running the Enhanced Mosaic Software

To run the Enhanced Mosaic browser, double click your mouse on the Spry icon. Windows, in turn,
will display the Enhanced Mosaic window as shown in Figure 84.



Figure 84 The Enhanced Mosaic window.

Within the URL field, type in the Web address of the site you desire. To display a Web site's 
information, your browser must download file information across the Web. As the Mosaic browser 
returns the information from across the Web, it will spin the small Spry Mosaic icon. The spinning 
icon is your indication that your browser is working. At the bottom of your screen, you will find a 
status bar that indicates how far the browser has progressed with the download. 

To end the Enhanced Mosaic program, select the File menu Exit option.

GETTING MORE INFORMATION ABOUT THE I-LINK WEB BROWSER

As you spend time on the Web, you can save considerable time and effort using the browser's 
advanced features. To learn more about the Enhanced Mosaic Web browser, select the Help menu 
option. Within the browser's online help, you will find extensive information about all browser 
capabilities.

DISABLING YOUR I-LINK 

I-Link will not charge you for use of their service during your trial period. Should you decide to 



terminate your I-Link account, click your mouse on the I-Link icon and open the I-Link window. 
Within the I-Link Shop sheet, click your mouse on the Cancel button. The I-Link software will 
connect your PC to I-Link and terminate your account. If you experience any errors in canceling 
your I-Link account, contact I-Link immediately by phone, fax, and electronic mail:

I-Link
One Chisholm Trail
Suite 4250
Round Rock, TX    78681
Tel: 512-388-2846 800-454-6599
Fax: 512-244-9681
E-mail: support@i-link.net
Web: http://www.i-link.net



ACCESSING THE WEB FROM AUSTRALIA

To access the Web from Australia, use AUSNet Services, one of Australia's largest Internet 
providers. To make it easy for you to try out the World Wide Web, AUSNet offers readers of the 
World Wide Web Directory 10 free hours of access! To obtain the software you need, contact 
AUSNet below:

AUSNet Services Pty. Ltd.
Suite 4, Level 9, Gold Fields House
1 Alfred Street
Circular Quay, NSW 2000, Australia
Tel: 61-2-241-5888
Fax: 61-2-241-5898
Web: http://www.world.net/

From the AUSNet Web site, you can download tons of software which will give you access to all 
sorts of Internet utilities, such as Gopher, Archie, WAIS, and much more!    



ACCESSING THE WEB FROM CANADA

To access the Web from Canada, you can use the Prodigy Information Service or the CompuServe 
Information Service previously discussed. To obtain an account with an Internet provider, contact:

Alberta Supernet Inc.
10909 Jasper Avenue
Suite 325
Edmonton, Canada T5J3L9
Tel: 405-441-3663
Fax: 405-429-0743



ACCESSING THE WEB FROM THE UNITED KINGDOM

To access the Web from the United Kingdom, contact the following Internet providers:

Demon Internet Ltd
Gateway House
322 Regents Park Road
Finchlay, London N3 2QQ UK
Tel: 44-(0)-181-371-1000
Fax:44-(0)-181-371-1150

Demon Internet Ltd has different subscription promotions. Let them know you learned about their 
service through the World Wide Web Directory. 

Frontier Internet Services Ltd
Tel: 44-(0)171-242-3383
Web: http://www.ftech.co.uk/~ita/



ACCESSING THE WEB FROM MEXICO

To access the Web from Mexico, contact the following Internet provider:

PixelNet
Tel: (in Mexico) 918-335-8166

(Montery) 335-8166
(US) 011-528-335-8166

E-mail: info@pixelnet.pixel.com.mx
Web: http://www.pixel.com.mx



ACCESSING THE WEB FROM GERMANY

To access the Web from Germany, contact the following Internet provider:

EUnet Deutschland GmbH
Emil-Figge Strasse 80
D 44227 Dortmund
Germany
Tel: 49-231-972-2222
Fax: 49-231-972-1111
E-mail: info@Germany.EUnet



ACCESSING THE WEB FROM THE NETHERLANDS

To access the Web from the Netherlands, contact the following Internet provider:

EUnet Communications Services B.V.
Singel 540, 1017 AZ Amsterdam, NL
Tel: 31-(0)20-623-3803
Fax: 31-(0)20-622-4657



ACCESSING THE WEB FROM ROMANIA

To access the Web from Romania, contact the following Internet provider:

EUnet Romania
Web: http://www.Romania.EU.net



ACCESSING THE WEB FROM SLOVAKIA

To access the Web from Slovakia, contact the following Internet provider:

EUnet Slovakia
c/o Computing Center of MFF UK
Room M-263 Mylinska dolina
842 15 Bratislava, Slovakia
Tel: 427-725-306
Fax: 427-828-462
Web: http://www.eunet.sk/




